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Axon 2 manual

Welcome to the Axon 2 manual. This manual is designed to get you up and running as quickly as possible. It can be read either on-line or off-line
(see below). If you prefer to read from a printed copy, follow the off-line instructions to download the PDF which you can then print.

Manual requirements
To complete the exercises in this manual the user will need the Axon 2 installation package and a PC.

Click the icon to go to the Axon 2 download page.

Before reading this manual, you should have completed the setup and operations manual for your machine and be familiar with:

the print materials, and
extruder setup.

On-line reading (essential notes)
For on-line reading, if left idle for over 120 minutes, technical resources will automatically time-out and direct you to a log in page. Please note the
details below. Simply enter:

Username: bfbcustomer
Password: 3D printing
Check the "Remember me" box

This will prevent the timeout from happening again during your session.

http://3dpedia.3dsystems.com/display/BFBCustTechRes/Download+Axon
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You can start reading the manual by clicking the links on the navigation bar at the left of the screen:

Off-line reading
Simply click on the "Export this space" button at the top left of the screen to export the manual to a PDF. Follow the on screen instructions.
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If you have a slow internet connection, it is possible to select individual sections of the manual to export, making it possile to download small
sections at a time. Simply tick the boxes next to the sections you need.

Alternatively, if bandwidth is not an issue, select all.
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1. Axon 2 overview

What does Axon do?

Axon converts all STL files (your digital 3D model files) into print files for all BFB printers, as illustrated below. Compatible BFB printers include:

RapMan 3.0, 3.1, 3.2
BFB-3000 (Plus)
3D Touch

Video tour

The videos below give a brief look at the Axon processes:
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2. Installing Axon

Recommended computer requirements

Operating System: Windows 7, Windows Vista, Windows XP
3D accelerated graphics hardware
128MB dedicated (non-shared) graphics memory
DirectX 9.0
Dual core processor
2GB RAM

Download

Click the icon to go to the Axon 2 download page.

Installation instructions

Please follow these installation instructions carefully.

After downloading, run the Axon setup file.
Choose where you want the Axon to be installed.

http://3dpedia.3dsystems.com/display/BFBCustTechRes/Download+Axon
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After installing Axon, the installer will also ask for Python to be installed. You must install Python in the default location when prompted
(C:\Python27). 

 You must install Python in the default location when prompted (C:\Python27) otherwise Axon will not work
properly.

Trouble installing Python
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If the Python installer ends prematurely then follow these instructions.

Press the 'windows' key and R on your keyboard to open the Run program dialogue:

Then copy one of the following paths into the text box, depending on operating system:
Windows 7 or Windows Vista: "C:\Program Files (x86)\Bits from Bytes\Axon 2\Python Setup\python-2.7.2.msi"
Windows XP: "C:\Program Files\Bits from Bytes\Axon 2\Python Setup\python-2.7.2.msi"
(If you installed Axon 2 to anywhere other than the default location then you will need to modify the relevant path above.)
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This should re start the Python installation.
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3. If this is your first time using Axon…

We aim to keep the control of our 3D printers as open as possible whilst maintaining ease of use, allowing you to experiment and with new materials
and new ideas. To do this, Axon will sometimes present different options. If this is your first time using Axon look out for the "Green tick" icons in this
manual (shown below). These are BFB recommended settings or configurations which will help get you on the road to a successful first print.
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4. Setting up Axon

Run Axon

Click Start > Programs > Bits from Bytes > Axon 2

Setting up Axon

After running Axon, click on the Settings tab > "Printer Configuration". If this is the first time you are running the program, you will not need to find
the button. The "Pinter configuration" dialogue will appear automatically:

Please take the time to set this correctly:

Printer type: select your BFB printer.
Extruders: input the number of extruders on the printer.
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Extruder 1 Material: input the material currently loaded on this extruder.
Extruder 2 Material: input the material currently loaded on this extruder, if present.
Extruder 3 Material: input the material currently loaded on this extruder, if present.

Click "OK" to save your settings and start using Axon.
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5. Axon interface
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6. View controls

Click on the "View" tab:

Use the tools above to achieve different views of the bed.
Also use the mouse over the print space for dynamic viewing:

Mouse action Result

Left click and drag Rotate

Mouse wheel Zoom

Panning is not yet available.
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7. Opening and closing STL files in Axon

STL file preparation

Axon processes STL model files. If you are new to STL files, please refer to  for fullExporting your STL files from your 3D modeller for Axon
information about the STL file requirements.

Open an STL file

Click on the "Home" tab and click on the "Open" icon to open the file:

The STL is loaded on the bed (example shown below):

Opening multiple STL files in Axon

Axon does not currently support opening more than one STL file at a time.

Closing an STL

To remove the STL from the print space in Axon, click on the "Close" button:
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8. Positioning an STL file

Moving the model around the bed

From the "Top view", (see View controls), drag the model around by holding down the  and dragging.right mouse button

If the model exceeds the printable area, a red bounding box will appear. Drag the model back towards the centre until the red box disappears.
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Rotating a model

On the "Home" ribbon tab, use the "Rotate Geometry" ribbon group to rotate the model.

Snapping a surface of the model to the bed

Left click on a surface on the model to snap that surface to the bed.

Troubleshooting:

If the model rotates into a position outside the printable area a red box will appear. Drag the model back towards the centre of the bed as
described above.
If the model disappears, it is best to "Close" the STL and re-open it (see "Open an STL file").
If Axon is unable to snap a surface to the bed, use the model rotation tools described above instead.

Scaling a model

On the "Home" ribbon tab, use the "Scale Geometry" ribbon group to scale the model.



Axon 2 user manual

Page 20

Level Base Check

Using the "Left View" or "Right View" tools make sure that the base of the model sits flat against the bed.

Troubleshooting:

If the base is not level on the bed, use the model rotate buttons to finely rotate the model in 0.5 or 1 degree increments.
Ensure that the base of the model is actually flat! If not, rectify in you 3D modeller.
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9. Overhangs and support scaffolds

If your model has any overhanging features, it may require printed sacrificial support scaffolds which can be automatically generated in Axon. These
support scaffolds can be printed in a different material to the model build material to facilitate removal. When the model has finished printing the
support material is disposed of, by either breaking it away, or disolving it. Methods on disolving support material are covered in section 12. Print

.materials

This section explains overhangs and how the support scaffolds work.

The layering process

The BFB printing process prints one layer at a time to build up the model. This means that material needs to reside underneath each new layer to
support the print. In the example below, the model material from previous layers successfully supports the new layer.

Overhanging features

If the model has any steep overhanging features, as per the example below, previous layers of model material will not reside underneath areas of
the overhang. (  the example below is only to illustrate overhangs – this particular model would never normally be orientated like this because itNote:
can be simply rotated to eliminate the overhanging feature).

When printing the first layer of the overhang, if left unchecked, the print area of the overhang will be unsupported:
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Without support, this overhanging layer (and therefore the layers to follow) would fail because they will sag down.

Support scaffolds

Support material can be used to solve the problem of overhanging features. If required, Axon can automatically detect overhanging features and
generate support scaffolds to support model overhangs:

If support material is required, you can set Axon to automatically generate scaffolds during the .build process

Overhangs which do not require support scaffolds

Not all overhangs require support material. This depends on the geometry of the overhang.

Overhang angle

The angle of the overhang is important. This is measured as shown below:

The table below illustrates typical overhang requirements for support scaffolds.  as requirements are geometry dependent:This is a guide only
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Overhang angle Support scaffold required?

Less than 50° No

Greater than 50° Yes

Bridging

There are some combinations of geometry and build settings where support scaffolding is not needed for overhangs which "bridge" a gap.
Consider the example of an arch, as shown below.

In this example, the overhang bridges two pillars. This means that the bridging layer is loosely suspended, which may be sufficient to print without a
support scaffold. Again, this is geometry and build settings dependent (e.g. it may not be possible to span a longer bridge with the same pillars).
The optimum layer thickness for utilising this build technique is 0.25mm. This yields the optimum ratio of X-Y speed to extruder flow rate for bridging
gaps without support scaffolding.
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10. Efficient model orientation and design

Axon allows you to generate an efficient build by giving you control over the model orientation, and allowing you to print without support material.
You may also be able to tailor your design in your 3D modeller to suit the build process by reducing steep overhanging features.

Model orientation

You may attempt to build a model in any orientation in Axon. However, depending on your model geometry some model orientations will be
significantly more efficient to print than others. A good model orientation can reduce the number of overhanging features in the build and reduce the
need for support material, thus saving build time and cost.
The table below shows how to position two different geometries into optimum orientations, eliminating the overhangs and the need for support
material.

Designing out the need for support material

Knowing that 45° overhangs can survive without support material, it may be possible at the 3D modelling stage to design out overhangs which
require support material. Check section  for more documentation on designing out the need for support material.18. Design for printing
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11. Does my model need support material?

The previous sections explain the  and ways to  unnecessarily. The flowchart below is designedconditions for needing support material avoid using it
to make it easy to check all the model properties before deciding whether to use support material or not. All terms in the flowchart are defined in the
previous sections.

 this is a guide only, as the approach for all prints is dependent on the geometry of the parts.Note:
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1.  

2.  

12. Print materials

As default Axon supports two print materials: PLA and ABS. Both have different properties and can be used in different build/support combinations.

PLA

PLA is a hard plastic with a low environmental impact. It is not a petrochemical - it is derived from renewable resources, such as starch. It is a
relatively new plastic and has excellent print characteristics.

As a build material: Good for large and small prints. Stable for 20 years up to 50 degrees Celsius

As a support material: Supports ABS well as it peels away easily. May be dissolved if required (see below).

PLA support can be dissolved by:

Leaving the model in an ultra-sonic  with water and caustic soda. Time and concentration depends on the volume ofsupport removal tank
the material needed to dissolve.
Leave the model in water at 80°C for over 48 hours. The  also provides this functionality.support removal tank

ABS

ABS is a well-known plastic with excellent toughness characteristics. ABS cannot be efficiently dissolved.

As a build
material:

Good for small prints with high toughness requirements. Do not print area larger than 100 mm square – ABS has relatively
high shrinkage on cooling, and some geometries for larger prints are prone to warping.

As a
support
material:

Supports PLA well as it peels away easily.

Which material combination should I use?

In general, we recommend using ABS for the raft and PLA for the model material. The table below lists the main combinations of materials and their
characteristics:

  Model
material

Raft
material

Support
material

Benefits Warnings

  PLA PLA None Available for single head prints. Raft may require sanding for complete removal.

PLA ABS None Recommended: Large PLA print size
possible. Model peels away well from the
ABS raft.

 

  PLA ABS ABS Large PLA print size possible. Model peels
away well from the ABS raft.

Avoid large support material areas due to ABS
warping.

  ABS ABS None Available for single head prints. Raft may require sanding for complete removal. Do
not print beyond a 100 mm  due to ABS warping.2

  ABS PLA None Model peels away well from the PLA raft. Do not print beyond a 100 mm  due to ABS2

warping.

  ABS PLA PLA Model peels away well from the ABS raft. Do not print beyond a 100 mm  due to ABS2

warping.

http://3dpedia.3dsystems.com/display/BFBSUPPORTREMOVALTANK/Support+removal+tank
http://3dpedia.3dsystems.com/display/BFBSUPPORTREMOVALTANK/Support+removal+tank
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13. Building a print file

"Building" refers to the process of converting your STL file into a BFB print file. The build dialogue offers different build options to achieve different
prints.

Starting the build
Build style profile
Layer thickness
Raft
Support material
Part material
Fill density
Fill pattern
Speed multiplier
Advanced settings
Set Default Values
Building the file

Starting the build

When you are happy that the STL is in position, on the "Home" tab click the "Build" button to show the build settings dialogue.

The "Build Settings" dialogue will show. It is important to understand all of these options to ensure that you get the results you expect.
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Build style profile

After setting up your build, you can optionally save your particular combination of settings as a profile. The profile can later be loaded and your
combination of settings restored. Click "Save as", then enter the name of the profile and click OK. Your new profile will be available in the drop-down
box.

Layer thickness

Printing thin layers produce good surface finish, but takes more time. Thick layers give a rougher finish, but are quicker to print.

  Layer thickness
(mm)

Print quality Print time

  0.125 Better than average.
Able to print steeper overhangs. Less effective at bridging gaps without
support material.

Twice as slow compared to 0.25
thickness.

0.25
(recommended*)

Nominal quality. Nominal speed.

  0.5 Rougher than average.
Less effective at printing overhangs due to further reach needed per
layer.

Twice as fast compared to 0.25
thickness.

*0.25 mm is a standard layer thickness which should be used as a starting point for all prints. Because all 3D printing is dependent on the geometry
of the part, we recommend trying this first before attempting the other two layer thicknesses.

Raft

The raft secures the model to the bed, and caters for any unevenness in the bed surface. Rafts are automatically generated in Axon.

We recommend using a dissimilar material for the raft to the build material. This is so that the raft can be easily peeled away model after the print is
finished.

We recommend the use of ABS as a good raft material (see section TODO).

Support material

Support scaffolds can be generated to print overhanging model features, as explained in Section TODO: ref. If possible, it is best to avoid the use of
support material if possible to reduce print time and cost (see Section TODO: ref to learn how to avoid using support material and section TODO: ref
to verify if support material is finally needed).
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Select 'none' if possible. 
If support material is needed, we recommend the use of ABS (see section TODO) to be used with the PLA build material (see Part
Material).

Part material

Part material is the material in which the model is printed.

PLA the best part material as it suffers from very little distortion during the print (see section TODO).

Fill density

When a 3D model is processed, the skin of the outside of the model is drawn, and then the profile is "filled in", as shown below. Fill density refers to
the density of this filling process.

A single layer in the middle of the build:
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The images below illustrate the effect of different fill densities for the same layer:

20% is a good fill for most prints. If additional strength is needed, fill density may be increased to suit.

Fill pattern

Axon offers four different styles of fill:

Recommendation Pattern Description Notes

Linear Fastest infill, quieter printer operation

  Lattice  

  Hexagonal  
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  Cylindrical  

Speed multiplier

The speed multiplier increases print speed, but the print may suffer a slight loss in the quality of the surface finish depending on the model
geometry.

1.0x speed as a good compromise for most prints.

Advanced settings

The advanced settings control the amount of material deposited on the outside surfaces of the part.

Skins refers to vertical walls, or walls with an angle of up to and including 65° from the vertical.
Surfaces refer to horizontal surfaces, surfaces which are inclined at less than 25° from the horizontal.

Processed, they appear as follows:
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Essentially, the skins build up the wall of the model, and the surfaces close off the walls at the top with 100% fill to seal off the model. If surfaces did
not exist, the 20% fill pattern would always be visible from the top and bottom of the model.

Set Default Values

Resets all settings to default

Building the file

Click OK in the build dialogue to start the build. You will be presented with a progress dialogue, which on completion, will display the build data:

Click "OK" once the build has finished.
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14. Viewing the print file

Once the STL file has been processed, Axon displays the BFB print file. This is a visual representation of the toolpaths the printer will use to print
the model. You cannot edit these toolpaths, but Axon provides various tools for viewing them if you need to.
Use the scroll bar at the right of the window to scroll through the print file layers:

During scrolling, a shadow of the original STL model will exist. If desired, this can be removed by clicking on the "Close STL File" button on the
"Home" ribbon tab.

The view tab can be used to pick out views of individual toolpaths:

For example, it is possible to pick out an individual layer at 14.25 mm high from extruder 2:
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15. Saving files to external media

Files must be saved to SD card or USB memory stick depending on your printer version.

When saving to external media, . Files inside folders will not be found by the printer.always put the BFB file at the root
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1.  
2.  
3.  

1.  
2.  
3.  
4.  
5.  
6.  
7.  

16. Multi-material build

Axon 2 includes a feature for printing parts in multiple materials. At its simplest, printing a part in multiple materials allows the use of different colours
for regions of the part. In taking the concept a step further, materials can be developed for extrusion in BFB printers so their physical properties can
be exploited. E.g. conductivity for electrical connections or flexibility for hinges etc.

STL requirements

In order to use the multi material printing feature, three STL files need to be generated in CAD software:

Combined part STL file. This is used to generate the raft and any support material toolpath.
Part material A STL file. This is used to generate the toolpath for the extruder containing material A.
Part material B STL file. This is used to generate the toolpath for the extruder containing material B.

How to generate the STL files

All STL files must have the same datum. This ensures that the parts will be built relative to each other.

Axon will not allow the multi-material STLs to be rotated after they have been imported. Therefore, ensure that Z direction for your 3D
model is true (i.e. up!).

Axon will not allow the multi-material STLs to be scaled after they have been imported. Therefore, ensure that your model is to scale
in your 3D modeller.

In order to obtain the STL files for material A and material B, one approach is to use the CAD software to:

Create the model to its combined volume.
Export this volume to STL file, including "combined" in the filename.
Remove the regions of the model that are to be printed in material B.
Export the remaining regions to an STL file, including "material A" in the filename.
Use the CAD software undo feature to restore the previously removed regions.
Remove the regions of the model to be printed in material A.
Export an STL file, including "material B" in the name.
For some 3D modelling packages (e.g. Google SketchUp) the concept of visual layers can be used so that one layer is used to for regions
of the model to be printed in material A and another layer to for regions of the model to be printed in material B. The layers can then be
turned on and off thus allowing easy selection and export of the regions to be used for each material.

How to load the multi material STL files into Axon

This example assumes a 2 extruder printer, and that the build does not require support material.
On the home tab, click "Open Multi Material":



Axon 2 user manual

Page 38

Load the STL files as per dialogue:

Click OK to load the model into Axon. Check that all both files are in register with each other.

Click the Build button to show the build settings dialogue. Allocate the materials as required.

"Part Material A" refers to the material to be used to print the STL file loaded as the "Material A STL" file.
"Part Material B" refers to the material to be used to print the STL file loaded as the "Material B STL" file.
In this example we are making the body (part A) out of PLA, and the ring (part B) out of ABS. We are using an ABS raft and have chosen to
use no support material in this example.
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The result shown in the build file preview:

Another multi-material example

This example assumes the same geometry as the previous example, using a triple extruder printer. This time, the parts are to be made out of
different PLA colours. Support material is also required for the overhang:
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The result shown in the build file preview:
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17. Material editor (advanced)

The material editor is for those who would like to experiment with new materials (i.e. materials other than PLA and ABS), or to change how ABS and
PLA are printed. If you only want to print using BFB supplied ABS and PLA with default settings, you do not need to read this section. 
The material editor allows you to operate the printer in order to print other materials. By creating a new material in Axon, you define a new set of
parameters which the printer will use to print the new material.

BFB protected materials

As you will notice, on first opening the parameters are greyed-out and inaccessible. This is because it is displaying a protected BFB material
configuration. You are not allowed to edit BFB material configurations. But you can create your own, which you are free to edit and save.

Create your own material

Choose a profile you would like to use as a template from the drop down box at the top of the editor, then click "Save As". Enter your new profile
name and click OK.



Axon 2 user manual

Page 42

You will notice that all parameters are now active and editable. After editing, click OK to save.

Do not use "ABS" or "PLA" for the  of your new profile name. This will cause the part first layer temperature tofirst three characters
be set incorrectly if your new material is set as the raft material in the build settings.

Editable material parameters

Note: The extruder uses a threaded drive screw to push the filament through the nozzle. The pitch of this thread is 1.00 mm.

Parameter Notes

Nozzle
diameter (mm)

Diameter of the nozzle at the end of the extruder

Cost per KG Enter the cost of your filament per kilogram here.

Standby
temperature
(°C)

Temperature at which the extruder is maintained when it becomes inactive during a print.

Raft
temperature
(°C)

When used as a raft, the temperature to be extruded at.

Support
cooling

When used as a support material, should fans be used to cool it down during extrusion?

Part cooling When used as a print material, should fans be used to cool it down during extrusion?

Prime amount
(revolutions)

Before moving to the print, an active extruder can be primed over the waste bin. If priming is desired, this defines the number
of drive screw revolutions over the waste bin before wiping and moving to the build area to start printing.

Prime speed
(RPM)

Speed of prime (defined above). RPM refers to revolutions of drive screw per minute.

Reverse
amount
(revolutions)

Defines how much to reverse the extruder when the extruder becomes inactive i.e. head change. This can prevent material
"oozing" from the nozzle whilst inactive.

Reverse speed
(RPM)

Speed of reverse (defined above)

   

Layer
thickness (mm)

Thickness of each printed layer.

Part:  

Extruded width
(mm)

Typical thickness of extruded track during a print.

Feed rate
(mm/s)

XY speed of extruder during a print.

Flow rate
(RPM)

Revolutions of the drive screw per minute during a print.

Perimeter
width (mm)

Thickness of extruded track at the boundary of a model.

Temperature
(°C)

Extrusion temperature during a print.

First layer
temperatures:

Extrusion temperature for the first layer of the part. This is different to ensure that an appropriate weld is made with the raft.

ABS raft (°C) First layer temperature if an ABS raft is detected.

PLA raft (°C) First layer temperature if a PLA raft is detected.

Other raft (°C) First layer temperature if a custom raft material is detected i.e. raft profile name does not begin with "ABS" or "PLA".
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Support
temperature
(°C)

Extrusion temperature if the material is used as support material.

Flow rate
(RPM)

Speed of extrusion if the material is used as support material.

How to use your new material in the build

Enter "Printer Configuration" (under the "Settings" tab) and configure Axon to have your new material in the extruder used to print it. When you
return to the build dialogue, your new material will appear in the material selection boxes.
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18. Design for printing

Designing for printing can make your prints faster, more cost effective and yield more reliable print results. The following sections are resources for
designers using 3D modellers to make parts to be printed on all BFB printers.

Designing out the need for support material
Thin wall thicknesses
Hole sizes for bolts

Summary
Recommendation
Explanation for the need to use hole correction factors

Designing out the need for support material

The examples shown below assume that the build orientation of the features cannot be changed, therefore 45° overhangs have been incorporated
into the design solutions to eliminate the use of support material. Note: the maximum overhang angle is entirely geometry dependent.
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* Depending on the size of these features, the examples may suffice without support material and without modification due to bridging.

Thin wall thicknesses

The BFB process creates parts by drawing out thin tracks of filament. The nature of this process means that, when printing a thin wall, yields three
different types of thin wall section:
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Wall type Strength Print speed Self-support on steep overhanging angles

Single filament wall Low Fast Low

Double filament wall, bonded Medium Medium Medium

Double filament wall, with infill High Slow High

Thin walls must be deisgned to a specific thickness to achieve a specific wall type. This thickness depends on print layer resolution and material
type:

Material   ABS ABS ABS PLA PLA PLA

Layer resolution (mm)   0.125 0.25 0.5 0.125 0.25 0.5

               

Wall result Image STL wall thickness (mm)

Axon ignores wall thickness - 0-0.4 0-0.6 0-0.6 0-0.3 0-0.4 0-0.6

Single filament wall 0.5-0.6 0.7-0.9 0.7-0.9 0.4-0.5 0.5-0.6 0.7-0.8

Double filament wall, bonded 0.7-1.3 1.0-1.8 1.0-1.8 0.6-1.0 0.7-1.3 0.9-1.7

Double filament wall, with infill 1.4+ 1.9+ 1.9+ 1.1+ 1.4+ 1.8+

Notes:

For all thin walls, actual printed thickness may be oversize.
For double filament wall without infill: as thickness increases filaments may begin to separate completely and leave an air gap between the
two filaments. To guarantee filament bonding it is best to choose a wall thickness at the lower end of the thickness range, or choose a wall
thickness in the range with infill.

Hole sizes for bolts

Summary
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When designing holes, the user must enter diameter correction factors to ensure that the printer creates a hole which fits the bolt. Correction factors
can be determined with a hole gauge (see 'Recommendation'). See 'Explanation' for the reason correction factors must be used.

Recommendation

We recommend printing a "hole gauge" which can be used to detect clearance diameters and tapping diameters for bolts. Once printed, simply offer
up the bolt up to the gauge to find out which design diameter provides the desired feature. The links below to download a hole gauge for designed
holes 1.0 – 8.9 mm.

Hole gauge STL file Click here

Hole gauge BFB file, 0.125 mm layer thickness (E1: ABS, E2: PLA) Coming soon...

Hole gauge BFB file, 0.250 mm layer thickness (E1: ABS, E2: PLA) coming soon...

The diagram below identifies the designed hole diameters for the attached hole gauge:

Explanation for the need to use hole correction factors

Correction is a necessity during the design phase because of the nature of the printing process: the illustration shows that a filament segment forms
the boundary of the hole. This segment is drawn around the radius of the hole, thus the inside of the segment is under compression. This causes the
plastic to spill slightly into the hole.

Unfortunately Axon is unable to detect hole features for automatic correction due to the nature of the STL file format, therefore the user must enter

http://3dpedia.3dsystems.com/download/attachments/46432746/Hole+range+1+to+8mm.stl?version=1&modificationDate=1316707513920
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certain correction factors when designing the hole feature.
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19. Exporting your STL files from your 3D modeller for Axon

What is an STL file

"STL" is a file format which describes the geometry of a 3D part. It is a universal file format which can be read by most 3D applications, including
Axon.
An STL file uses triangular facets to represent 3D surface geometry.

How to export an STL file from the 3D modeller

Typically, a 3D modeller will be able to generate an STL file* by clicking either "Save As…" or "Export" in the "File" menu. If not, please refer to your
3D modelling documentation.

In the export dialogue, make sure you check the export options. There is usually an "Options" button in the dialogue. See the next
section to learn how to configure the typical options. This is important as it can affect the quality of your print

* At the time of writing, Google Sketchup does not export STL files directly. Two free STL solutions for Google Sketchup are hosted at , andguitar-list
.cerebral meltdown

Important export options

Export options are usually available in the STL export dialogue, as shown below. If not, please refer to your 3D modelling documentation.

http://www.guitar-list.com/download-software/convert-sketchup-skp-files-dxf-or-stl
http://www.cerebralmeltdown.com/cncstuff/stl/index.htm
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The options shown below are from Autodesk Inventor 2011, however the export options are broadly similar across most 3D modelling packages.
This section will only cover the important options.

Format

Select binary format (ASCII will simply put the data into a readable format, unnecessarily increasing the file size).

Units

Setting this correctly will save needing to rescale your model in Axon.

Accuracy/Resolution

The resolution of the STL file is important for curved surfaces in your model.

If the resolution is too low, the triangular facets in the STL file will be visible in the print.
If the resolution is too high, the file may take an unacceptably long time to process in Axon.

In the example below a half-sphere is processed using AutoDesk Inventor.
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Low export resolution Medium export resolution High export resolution

Surface deviation: 0.024
Normal deviation: 30.0
Max edge length: 60.0

Aspect ratio: 21.5

Surface deviation: 0.010
Normal deviation: 15

Max edge length: 60.0
Aspect ratio: 21.5

Surface deviation: 0.003
Normal deviation: 10

Max edge length: 60.0
Aspect ratio: 21.5

File size: 106 kB File size: 254 kB File size: 808 kB

Axon process speed: Faster Axon process speed: Nominal Axon process speed: Slower

Facets visible in print: Yes Facets visible in print: No Facets visible in print: No

   

Inventor uses the following export parameters:

Surface Deviation: Controls the maximum distance between the facet edges and the surface edges.

Normal Deviation: Controls the maximum angle between the normal vectors of the facets.

Max Edge Length: Defines the maximum distance between the grid lines that are placed on the face during the tessellation process.
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Aspect Ratio: Controls the ratio between the height and width of the facets.

Note: Other 3D modellers may use different export parameters.

STL file problems and automatic repair

Some surface 3D modellers (e.g. Google SketchUp or Rhino) can have problems exporting a valid STL file. On importing your STL file into Axon,
Axon will automatically check your STL file and attempt to fix it if possible.
If this does not fix the problem, you may wish to consider using a more professional 3D modelling package, or a different STL export plugin.

Further STL questions

Please check our FAQ for further information on STL files (Technical Resources > Troubleshooting a problem > STL file preparation).
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20. How to edit Axon-generated BFB print files (advanced)

Axon generates .BFB files which are for immediate use with any BFB printer. Unless you are using the machine for research purposes, you do not
need to read this section.

The .BFB print file is readable with any text viewing program to give absolute control over the printers operation parameters. Axon builds the BFB
file using Gcodes.

Gcode Outline
Supported Gcode Commands

Movement Codes
Special functions (M Codes)

Gcode Outline

Some basic knowledge is required in order to identify which extruder is used for a particular purpose i.e. raft, model or support material. It is also a
requirement to identify which material the Gcode extruders are running by observing the temperatures in use.

Raft layers

The default raft generated in Axon consists of 2 layers at 0.7mm and 1.0mm.

Material Temperature Ranges:

ABS: 220 degC to 260 degC, the lower the temperature the less likely the layers will stick. 260 degC is the default temp and anything hotter than
270 degC could potentially damage the extruder head over time.

PLA: 180 degC to 220 degC, the lower the temperature the less likely the layers will stick. 195 degC is the default temp.

Supported Gcode Commands

Movement Codes

G1 Coordinated Motion - supports X, Y, and Z axes

G4 Dwell

G90 Absolute Positioning

G92 Sets an origin offset, which is currently used to set the extruder 2 X,Y offset from extruder 1. This can be overridden in the firmware.

G93 Set ignore G92 setting

Special functions (M Codes)

M101 Turn extruder 1 on forward at the RPM specified by a previous M108

M103 Turn all extruders off

M104 S145.0 Set Extruder 1 target temperature to 145.0 degC

M106 Turn part cooling fan on

M107 Turn part cooling fan off

M108 S400 Set Extruder 1 speed to S value/10 = 40rpm

M201 Turn second extruder on forward at the RPM specified by a previous M108

M204 S145.0 Set Extruder 2 target temperature to 145.0 C

M208 S400 Set Extruder 2 speed to S value/10 = 40rpm

M210 AUX 1 off (not on all hardware configurations)

M211 AUX 1 on

M220 AUX 2 off

M221 AUX 2 on
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M226 Pause the printer until ESC key is pressed

M227 S1000 P1000 on extruder stop (M103) reverse the extruder stepper for S turns and prime on extruder start (M101)

M228 Disable M227

M229 Same as M227 but P and S parameters specify prime and reverse extruder drive screw revolutions (not stepper steps)

M230 Disable / enable wait for temperature change

M301 Turn extruder 3 on forward at the RPM specified by a previous M108

M304 S145.0 Set target temperature of extruder 3 to 145.0 degC

M308 S400 Set Extruder 3 speed to S value/10 = 40rpm. (Note to turn off extruders 2 and 3 use M103 which turns off all extruders)

M542 - Enter 3000 nozzle wipe / move to RapMan rest location

M543 - Exit 3000 nozzle wipe / does nothing on RapMan

M551 / M552 / M553 - Prime extruder 1 / 2 / 3. Parameter P = stepper steps, S = RPM * 10

M561 / M562 / M563 - Reverse extruder 1 / 2 / 3. Parameter P = stepper steps, S = RPM * 10

For a reference sheet, you can download a PDF of these commands HERE

http://wiki.bitsfrombytes.com/images/d/d6/G-Code.pdf
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21. Appendix

Manual version

Version Description Date

1.0.0 Original release 13/01/2012
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Home

Appologies for the inappropriate pagebreaks during this export. We are trying to resolve this issue.
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